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Important Safety Instructions
1. Read the safety and operating instructions before operating the ZP-100.
2. Keep this User’s Guide for future reference.
3. Adhere to warnings and operating instructions.
4. Route power-supply cords so that they will not be walked on or pinched by items placed on or against them. Pay

particular attention to cords at plugs, convenience receptacles, and the point where cords exit the equipment.
5. Ensure that the location of equipment provides proper ventilation. For example, the equipment should not be placed

on a bed, sofa, rug, or similar surface that may block ventilation openings; or, placed in a built-in installation, such as
a bookcase or cabinet, that may impede the flow of air through the ventilation openings.

6. Locate the equipment away from heat sources such as radiators, heat registers, stoves or other appliances (including
amplifiers) that produce heat.

7. Do not use the equipment near water.
8. Clean the equipment by dusting with a dry cloth. Clean panel with cloth moistened with a window cleaner.
9. Service must be performed by qualified service personnel when the power cord or plug has been damaged, or objects

have fallen on the equipment, or liquid has been spilled into the equipment, or the equipment has been exposed to
rain, or the equipment does not appear to operate normally, or the equipment has been dropped.

10. Do not defeat the inherent design features of the polarized plug. Non-polarized line cord adapters will defeat the
safety provided by the polarized AC plug.

11. CAUTION: TO PREVENT ELECTRICAL SHOCK DO NOT USE A (POLARIZED) PLUG WITH AN
EXTENSION CORD, RECEPTICAL OR OTHER OUTLET UNLESS THE BLADES CAN BE FULLY
INSERTED TO PREVENT BLADE EXPOSURE.

The lightning flash with arrowhead, within an equilateral triangle, is intended
to alert the user to the presence of uninsulated “dangerous voltage” within the
product’s enclosure that may be of sufficient magnitude to constitute a risk of
electric shock to persons.

RISK OF ELECTRICAL SHOCK
DO NOT OPEN

CAUTION: TO PREVENT THE RISK OF ELECTRICAL SHOCK, DO NOT
REMOVE COVER. NO USER-SERVICEABLE PARTS INSIDE. REFER
SERVICING TO QUALIFIED PERSONNEL.

!
The exclamation point within an equilateral triangle is intended to alert the
user to the presence of important operating and maintenance (servicing)
instructions in the literature accompanying the product.
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  Preface ix

Preface

Thank you for purchasing the Zapex ZP-100 Real-Time Digital Audio Encoder.

This User’s Guide describes how to install and use your ZP-100. Please read through it
carefully.  After you have finished reading this User’s Guide, keep it handy for future
reference.

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the user will be required to
correct the interference at his/her own expense.

Special Note Concerning Use of Dolby Digital Trademark
Dolby Laboratories encourages use of the Dolby Digital trademark to identify soundtracks
that are encoded in Dolby Digital. This is an effective way to inform listeners of the
soundtrack format, and the use of a standard logo promotes easy recognition in the
marketplace. However, like any trademark, the Dolby Digital logo may not be used
without permission. Dolby Laboratories therefore provides a standard trademark license
agreement for companies who wish to use Dolby trademarks. This agreement should be
signed by the company that owns the program material being produced. Recording studios
or production facilities which provide audio production or encoding services for outside
clients generally do not require a trademark license. If you would like more information
on obtaining a Dolby trademark license, please contact Dolby Laboratories Licensing
Corporation. Information on trademark licensing plus instructions for using the Dolby
Digital trademark and marking audio formats can also be found on-line at
http://www.dolby.com. See Appendix D, “Use of Dolby Trademarks,” for more
information.

Dolby Laboratories Licensing Corporation
100 Potrero Avenue
San Francisco, CA 94520
USA

Phone: 415-558-0200
Fax: 415-863-1373
E-mail: tsa@dolby.com
http://www.dolby.com
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Hardware Description

Congratulations on purchasing your new ZP-100 Digital Audio Encoder. The ZP-100
comes in two or 5.1 channel Dolby Digital models. The 2 channel model can be upgraded,
see your dealer for upgrade information. The ZP-100 also encodes MPEG Audio Layer 2
and captures PCM audio.

System Requirements
ZP-100 Encoder requires the following minimum system configuration:

§ Microsoft Windows NT operating system version 4.0 with Service Pack 3 or higher

§ Personal computer with an available full size PCI slot

§ Pentium II 233 MHz or higher processor

§ 32 megabytes (MB) of RAM (64 MB recommended)

§ One 3.5-inch high-density disk drive

§ Two hard disk drives

§ One system disk drive with 2 MB of free space for ZP-100 Controller
§ One Ultra Wide SCSI disk drive for capturing audio files

§ PCM audio player for playing the source PCM audio stream

§ Dolby® Digital (AC-3) and/or MPEG audio decoder for monitoring your work
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Package Contents
Your ZP-100 comes with following components. Check the contents to make sure they are
included.
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ZP-100 Encoder

The ZP-100 Encoder is a full-size PCI card designed to fit inside a personal computer. It
can receive a real-time PCM audio stream and encode it into three types of audio.

§ Dolby Digital (AC-3)

§ MPEG Audio Layer 2

§ PCM

The encoding parameters can be adjusted to meet your requirements using the
ZP-100 Controller (described later).

ZP-100 Octopus Cable

The Octopus Cable connects a PCM audio player and an audio decoder to the
ZP-100 Encoder. The audio decoder must be a Dolby® Digital (AC-3) and/or MPEG
audio decoder.

The Octopus Cable has 8 plugs for making the connections to a player and decoder. The
table shown below describes each plug.

Plug Name Description
Multipin Concentrator This is the largest plug on the cable. It connects to ZP-100 Encoder.

Ch 1-2 This XLR plug connects to a PCM audio player and is the Channel 1 and
Channel 2 audio inputs to the encoder.

Ch 3-4 This XLR plug connects to a PCM audio player and is the Channel 3 and
Channel 4 audio inputs to the encoder.

Ch 5-6 This XLR plug connects to a PCM audio player and is the Channel 5 and
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Channel 6 audio inputs to the encoder.

Ch 7-8 This XLR plug connects to a PCM audio player and is the Channel 7 and
Channel 8 audio inputs to the encoder.

SPDIF IN This BNC plug connects to a PCM audio player and is the Channel 1 and
Channel 2 audio inputs to the encoder. This plug can be used as an
alternative for the plug labeled “Ch 1-2.”

TC IN This BNC plug connects to a PCM audio player and is the time code input
to the encoder.

SPDIF OUT This BNC plug connects to an audio decoder and is the audio output from
the encoder. The audio decoder can be a Dolby Digital (AC-3) and/or
MPEG Audio player. The audio output is encapsulated in an IEC958
format.

XLR OUT This XLR plug connects to an audio decoder and is the audio output from
the encoder. The audio decoder can be a Dolby Digital (AC-3) and/or
MPEG Audio player. The audio output is encapsulated in an IEC958
format.

Deck Control Cable

The Deck Control Cable is used for connecting your personal computer to a PCM audio
player. When connected to a Sony compatible remote control interface on the player, the
ZP-100 Controller software can do semi-automatic and automatic encoding.

RS232c to RS422 Serial Converter

The RS-232c/RS-422 converter connects your computer to the Deck Control Cable.
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Hardware and Software Installation

Installation Overview
The following procedures are required to install and configure your new encoding system.

§ Installing the ZP-100 Encoder

§ Connecting the ZP-100 Encoder

§ Installing the Software

§ Configuring the Encoder Settings

§ Remote Control Setup

Installing the ZP-100 Encoder
The ZP-100 Encoder is designed to be installed into a personal computer (PC) with a free
full-size PCI slot.

WARNING: Make sure that you are physically grounded to the personal computer in which
the ZP-100 Encoder is to be installed and that the PC is disconnected from any power
during the installation process.

To install the ZP-100 Encoder:

1. Turn your PC off and disconnect it from any power source.

2. Open your PC so that a PCI slot can be accessed. For detailed instructions, refer to the
PC’s user’s guide.

3. Unfasten the back plane cover for the selected PCI slot by removing its sheet metal screw.

4. Insert ZP-100 Encoder into the free PCI slot.

5. Use the sheet metal screw to fasten the ZP-100 Encoder to the computer’s back plane.

6. Replace the cover to your PC as described by its user’s guide.
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Connecting the ZP-100 Encoder

The diagram below illustrates how the Octopus Cable and Deck Control Cable connect the
ZP-100 Encoder to a PCM audio player and an audio decoder. The decoder must be able
to play Dolby® Digital (AC-3) and/or MPEG audio.

The ZP-100 Encoder simultaneously outputs a Dolby® Digital AC-3 or MPEG audio
stream, in an IEC958 format, to the XLR OUT and SPDIF OUT plugs. Therefore, either
one of these plugs can be connected to your decoder.

Caution: Before making any cable connections, make sure all units involved are turned off.
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Installing the Software
The software disks have a setup program that checks your computer and asks you
questions about how you want to install the software. The setup program installs the
following software.

§ ZP-100 Controller for Dolby Digital Encoding

§ ZP-100 Controller for MPEG Audio Encoding

§ PlayAudio

§ Drastic Deck Control Driver

Note: If you use a virus protection program on your system, turn it off before running the
set up program of the ZP-100 controller. The ZP-100 controller may not work correctly if
installed with your virus protection program turned on. After running Setup and
completing the install, you can restart your virus protection program.

To install the software:

1. Insert Disk 1 into the floppy drive.

2. Click the Start button, then click Run.

3. Type a:\setup in the Run dialog box, then click OK.

4. Follow the instructions on your screen. These instructions will lead you through the
installation process and prompt you to provide information, make some choices, and insert
the succeeding setup disks.
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Configuring the Encoder Settings
To configure the encoder settings:

1. From the Windows NT Taskbar, click Start, point to Programs, then to ZP-100, then
select either the Dolby Digital (AC-3) Encoder or MPEG Audio Encoder. Please
configure the encoder settings for both of the Dolby Digital (AC-3) and MPEG encoding
controllers.

2. From the Options menu, select Encoder Settings to open the Encoder Settings dialog
box.

3. Use the following table as a guide for configuring the Encoder Settings dialog box.

Control Description
PCI Device No. If two ZP-100 Encoders are installed, select 0 or 1 from the PCI

Device No. drop-down list to assign a specific Encoder to the
controller. Otherwise, accept the default value. Typically, the
Encoder nearest your computer’s CPU is identified as 0.

Number of Buffers Personal computers with slow microprocessors may experience
system crashes. To help resolve this problem, increase the
computer’s memory buffer size.

If necessary, increase buffer size from the Number of Buffers
text box. Each integer equals 64K of memory space with a
maximum of 128 buffers.

Select Interface for
Ch1 and Ch2

A two channel PCM audio stream can be accepted as an input to
the ZP-100 Encoder at the plugs labeled Ch 1-2 or SPDIF IN.

Depending on how the encoder is connected to the player, select
AES/EBU if using the Ch 1-2 plug, or SPDIF if using the SPDIF
IN plug.

During Standby Standby mode is when the ZP-100 Encoder is monitoring a source
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audio stream, but not encoding.

Use this drop-down list to configure the encoder’s output at the
XLR OUT and SPDIF OUT plugs during standby mode. Since
both of these plugs supply an output to an audio decoder, select
PCM if your decoder can play PCM audio, otherwise, select
Mute.

Note: Located in the Audio Service Configuration tab of the
ZP-100 Controller main window is the Audio Coding Mode drop-
down list. If set to 1/0 Single (mono), Channels 1 and 2 of the
XLR OUT and SPDIF OUT plugs will supply mono audio.

During Encoding Use this drop-down list to configure the encoder’s output at the
XLR OUT and SPDIF OUT plugs during encoding mode. Since
both of these plugs supply an output to an audio decoder, select
Encoded Stream if your decoder can play Dolby Digital (AC-3)
and/or MPEG audio, otherwise, select PCM.

Note: Located in the Audio Service Configuration tab of the
ZP-100 Controller main window is the Audio Coding Mode drop-
down list. If set to 1/0 Single (mono), Channels 1 and 2 of the
XLR OUT and SPDIF OUT plugs will supply mono audio.

Time Code Start/End When doing semi-automatic or automatic encoding, set the
accuracy of the start and end time codes.

Select Time Code >= Specified Start/End Time Code to make
the encoder automatically start or stop if it recognizes that a
specific time code has appeared and/or passed. The encoder may
not start and stop correctly because of a poor quality time code
signal supplied by the PCM audio player.

Select Time Code = Specified Start/End Time Code to
automatically start or stop encoding when encoder actually reads
the specific time code. If a specific start time code was not
received by the encoder for some reason, it will remain in
standby, and if a specific end time code was not received,
encoding will continue if this selection is used.

Create ZFS file A ZFS file, also called a Stream Structure file, contains
information about the AC3, MPEG, and PCM files. PlayAudio
(described in chapter 4) displays information from this file in its
main window. Select this checkbox to automatically create a ZFS
file whenever you encode. The ZFS will have the same name, and
be found in the same location as your captured file, but using the
ZFS filename extension.

Although PlayAudio can create ZFS files when needed, it does
not include peak wave data, the graphical representation of the
captured file. Only ZFS files created by using this checkbox
contain peak wave data.
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Erase Capture file if… Select this checkbox if you want to delete your captured file if
some fatal error occurs during the encoding session.

Remote Control Setup
If your PCM audio player supports the Sony RS-422 VCR Control Protocol, you can use
the ZP-100 Controller to remotely control the player for automatic encoding sessions. To
setup the remote control feature, you must connect the Deck Control Cable and configure
the Drastic Deck Control Driver.

Connecting the Deck Control Cable
Connect the Deck control cable as described in the “Connecting the ZP-100 Encoder”
section earlier in this chapter.

Configuring the Drastic Deck Control Driver
To configure the Multimedia Control Panel:

1. From the Windows NT taskbar, click Start, point to Settings, and then select Control
Panel.

2. Double-click on Multimedia to open the Multimedia Properties.

3. Click the Devices tab to bring it to the front.

 

4. In Media Control Devices select MCI Drastic RS-422 VCR Control.

5. Click Properties to open the MCI Drastic RS-422 VCR Control properties window.

6. Click Settings to open the Drastic Driver Config dialog box.
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7. From the Drastic Driver Config dialog box, make the following selections.

§ From the VTR Name drop-down list, select Sony Generic RS-422 Protocol.
§ From the COM Port drop-down list, select COM 1 or the port that the Deck Control

Cable is connected to.

§ Select the Auto TC radio button.

§ Select the Auto Edit radio button.

§ Depending on your needs, select the NTSC or PAL radio button.
 

 
 

8. Click OK to accept the changes.
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C H A P T E R  3

Getting Started

This chapter describes the ZP-100 Controller main window and explains the procedures
for Dolby® Digital (AC-3), MPEG Audio Layer 2, and PCM encoding, saving your work,
and exiting the ZP-100 Controller.

The ZP-100 Controller Main Window
When you start the ZP-100 Controller, the main window appears. The following
illustration identifies the major parts of the main window.
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Starting the ZP-100 Controller
To start the ZP-100 Controller:

From Windows NT Taskbar, click Start, point to Programs, then to ZP-100, then select
Dolby Digital (AC-3) Encoder to open the ZP-100 Controller for Dolby® Digital (AC-3)
encoding or MPEG Audio Encoder to open the ZP-100 Controller for MPEG Audio
Layer 2 encoding. Both controllers can be used to capture PCM audio

Encoding
NOTE: Procedures in this section use illustrations from the ZP-100 Controller for Dolby®
Digital (AC-3) encoding, however, they also apply to MPEG audio encoding. Detailed
information about configuring Dolby® Digital (AC-3), MPEG, and PCM audio parameters
are provided appropriately.

You can configure the ZP-100 Controller to manually, semi-automatically, or
automatically encode.

The ZP-100 operates in two modes, Dynamic Encoding mode and File Capture mode.
Dynamic Encoding mode is used to create parameter files, and do Broadcast Encoding.
Both Broadcast Encoding and the creation of parameter files require that a PCM source be
encoded and played, but not saved as a file. File Capture mode is capturing a file to disk
for playback later, like DVD.

Manual Mode
In manual mode, the ZP-100 will receive a PCM audio stream as it is played, then begin to
encode when you click the encode button.

To encode using Manual Mode:

1. Type the name for your new Dolby Digital (AC-3) or MPEG audio file into the Capture
Filename text box. If doing Dynamic Encoding, leave file name blank.
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2. Select the PCM Capture check box if you also want to capture PCM audio.

 

To change any PCM encoding parameters, click on the PCM Properties button to open
the PCM Capture Properties dialog box. See "PCM Audio Encoding Parameters” in
Appendix A for information about configuring the PCM Capture Properties dialog box.

3. From the Control Mode drop-down list, select Manual.

 
4. From the Options menu, select Output Format Settings to open the Output Format

Settings dialog box.

 

5. From the Stream Type drop-down list, select the type of audio file you want to produce.

Dolby® Digital (AC-3) stream type options:

Selection Description

Elementary Stream Elementary stream (AC-3 file format)

Elementary Stream with Time Code Elementary stream with time code (AC-3 file format)

IEC958 Stream Wave Format IEC958 stream (WAVE file format)

IEC958 Stream Wave Format with Time
Code

IEC958 stream with time code (WAVE file format)
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NOTE: For Dolby® Digital (AC-3) encoding, if you select an item that contains time code,
the encoder will include time code in the bit stream.

MPEG Audio Layer 2 stream type options:

Selection Description

Elementary Stream Elementary stream (MPEG Audio Layer 2 file format)

IEC958 Stream Wave Format IEC958 stream (WAVE file format)
 

6. From the Format drop-down list, select the type of IEC958 stream.

The tables shown below indicate which formats are Professional or Consumer mode, and
32-bit or 16-bit mode.

Dolby® Digital (AC-3) format options:

Selection Description

Professional 32-bit Bit stream on Channels 1 & 2

Professional 16-bit Ch 1 Data Packing Bit stream on Channels 1

Professional 16-bit Ch 2 Data Packing Bit stream on Channels 2

Consumer Bit stream on Channels 1 & 2
 

MPEG Audio Layer 2 format options:

Selection Description

Professional 32-bit Bit stream on Channels 1 & 2

Consumer Bit stream on Channels 1 & 2
 

7. From the Audio Status Bit drop-down list, select Non-Audio (Data). If the ZP-100 is
connected to a decoder that only accepts streams where the Audio Status Bit is audio,
select Audio.

8. Click OK to close the Output Format Settings dialogs box.

9. Accept the default encoding parameters shown in the Audio Service Configuration, Bit
Stream Info 1, Bit Stream Info 2, and Processing tabs.

 If you want to learn how to adjust the encode parameters in these tabs, see Appendix A,
“Dolby Digital (AC-3) Encoding Parameters” and “MPEG Audio Encoding Parameters”.
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10. Click Encode to open the Audio Encoder System Executor window.

 

11. When Manual Standby appears in the status bar, begin playing the PCM audio stream.

12. The attenuation for each input channel can be manually adjusted with the slide bar.

13. Click Start to begin encoding.

14. Click Stop to stop encoding.

15. If you specify the filename into the Capture Filename text box in Step 1, an audio file will
automatically be saved. If you leave the filename blank, an audio file will not be saved.

NOTE: Audio, parameter, and log files will be created; for more information, see “Files
produced by the ZP-100” later in this chapter.
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Semi-Automatic Mode
NOTE: Procedures in this section use illustrations from the ZP-100 Controller for Dolby®
Digital (AC-3) encoding, however, they also apply to MPEG audio encoding. Detailed
information about configuring Dolby® Digital (AC-3), MPEG, and PCM audio parameters
are provided appropriately.

REQUIREMENT: For this feature to work, the ZP-100 needs to have the TC IN connected to
the PCM audio player’s time-code out connection.

The ZP-100 operates in two modes, Dynamic Encoding mode and File Capture mode.
Dynamic Encoding mode is used to create parameter files, and do Broadcast Encoding.
Both Broadcast Encoding and the creation of parameter files require that a PCM source be
encoded and played, but not saved as a file. File Capture mode is capturing a file to disk
for playback later, like DVD.

ZP-100 Controller can semi-automatically encode from a specific block of PCM audio. A
block of PCM audio stream is defined as having a specific start and stop time code.

Semi-automatic mode requires that you manually start and stop your PCM audio player.
However, ZP-100 will read the time code as it is played and automatically start and stop
encoding based on start and stop time codes you have selected.

To encode semi-automatically:

1. Type the name for your new Dolby Digital (AC-3) or MPEG audio file into the Capture
Filename text box. If doing Dynamic Encoding, leave filename blank.

 

2. Select the PCM Capture check box if you also want to capture PCM audio.

 

To change any PCM encoding parameters, click on the PCM Properties button to open
the PCM Capture Properties dialog box. See "PCM Audio Encoding Parameters” in
Appendix A for information about configuring the PCM Capture Properties dialog box.
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3. From the Control Mode drop-down list, select Semi-Auto.

 

4. From the Options menu, select Output Format Settings to open the Output Settings
dialog box.

 

5. From the Stream Type drop-down list, select the type of audio file you want to produce.

Dolby® Digital (AC-3) stream type options:

Selection Description
Elementary Stream Elementary stream (AC-3 file format)

Elementary Stream with Time Code Elementary stream with time code (AC-3 file format)

IEC958 Stream Wave Format IEC958 stream (WAVE file format)

IEC958 Stream Wave Format with Time Code IEC958 stream with time code (WAVE file format)
 

NOTE: For Dolby® Digital (AC-3) encoding, if you select an item that contains time code,
the encoder will include time code in the bit stream.

MPEG Audio Layer 2 stream type options:

Selection Description
Elementary Stream Elementary stream (MPEG Audio Layer 2 file format)

IEC958 Stream Wave Format IEC958 stream (WAVE file format)
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6. From the Format drop-down list, select the type of IEC958 stream.

The tables shown below indicate which formats are Professional or Consumer mode, and
32-bit or 16-bit mode.

Dolby® Digital (AC-3) format options:

Selection Description
Professional 32-bit Bit stream on Channels 1 & 2

Professional 16-bit Ch 1 Data Packing Bit stream on Channels 1

Professional 16-bit Ch 2 Data Packing Bit stream on Channels 2

Consumer Bit stream on Channels 1 & 2
 

MPEG Audio Layer 2 format options:

Selection Description
Professional 32-bit Bit stream on Channels 1 & 2

Consumer Bit stream on Channels 1 & 2
 

7. From the Audio Status Bit drop-down list, select Non-Audio (Data). If the ZP-100 is
connected to a decoder that only accepts streams where the Audio Status Bit is audio,
select Audio.

8. Click OK to close the Output Format Settings dialog box.

9. Enter your desired start and stop time code using the HH:MM:SS:FF syntax. Time codes
can be entered by clicking on a specific time field, then typing a numeric value.

 Time codes may also be entered by clicking on the Start Time Code and Stop Time Code
buttons , located next to the time code text boxes, and using the Input Time Code
dialog boxes.

 

10. As an option, type a sample number into the Sample text box.

 One video frame may be divided into a number of PCM audio samples. The number of
PCM audio samples in a video frame is dependent on the PCM sampling frequency and
video frame rate. For example, when the PCM sampling frequency is 48 kHz and the
video farm rate is 24 fps, there are 2000 PCM audio samples in a video frame. Therefore,
this parameter allows you to narrow down your start time to a specific start sample within
a video frame. The default value is zero.
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11. From the Frame Rate drop-down list, select a frame rate.

 

12. Accept the default encoding parameters shown in the Audio Service Configuration, Bit
Stream Info 1, Bit Stream Info 2, and Processing tabs.

 If you want to learn how to adjust the encode parameters in these tabs, see Appendix A,
“Dolby Digital (AC-3) Encoding Parameters” and “MPEG Audio Encoding Parameters”.

13. Click Encode to open the Audio Encoder System Executor window.

14. Queue your PCM audio player to at least 10 seconds before the start time code you have
set in the ZP-100 Controller main window.

15. Begin playing the PCM audio stream.

16. When 5 seconds have passed since the PCM audio stream was started, click Standby.

 When ZP-100 reads the start time code, it will begin encoding the PCM audio stream into
a Dolby® Digital (AC-3) or MPEG audio bit stream. When it reads your selected stop time
code, it will automatically stop encoding.

 To stop the encoding process before the Stop Time Code arrives, click the Stop button
and what has been encoded will be saved.

 If the Cancel button is clicked, the encoding process will stop and stream will not be
saved.

 



22 ZP-100 User’s Guide

17. If you specified a filename in the Capture Filename text box in Step 1, an audio file will
automatically be saved. If you leave the filename blank, an audio file will not be saved.

NOTE: Audio, parameter, and log files will be created; for more information, see “Files
produced by the ZP-100” later in this chapter.
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Automatic Mode
NOTE: Procedures in this section use illustrations from the ZP-100 Controller for Dolby®
Digital (AC-3) encoding, however, they also apply to MPEG audio encoding. Detailed
information about configuring Dolby® Digital (AC-3), MPEG, and PCM audio parameters
are provided appropriately.

REQUIREMENT: For this feature to work, your PCM audio player must use the Sony P2
Protocol (also known as Sony 9-Pin Protocol) and also needs to have the time-code out
connected to the TC IN on the ZP-100’s Octopus Cable.

The ZP-100 operates in two modes, Dynamic Encoding mode and File Capture mode.
Dynamic Encoding mode is used to create parameter files, and do Broadcast Encoding.
Both Broadcast Encoding and the creation of parameter files require that a PCM source be
encoded and played, but not saved as a file. File Capture mode is capturing a file to disk
for playback later, like DVD.

The ZP-100 can automatically encode a specific block of PCM audio stream. Automatic
mode only requires that you enter start and stop time codes, then click Encode. The ZP-
100 Controller will automatically perform the entire encoding process. There is no need to
start, stop, or queue up your PCM audio player.

To encode automatically:

1. Type the name for your new Dolby Digital (AC-3) or MPEG audio file into the Capture
Filename text box. If doing Dynamic Encoding, leave filename blank.

 

2. Select the PCM Capture check box if you also want to capture PCM audio.

 

To change any PCM encoding parameters, click on the PCM Properties button to open
the PCM Capture Properties dialog box. See "PCM Audio Encoding Parameters” in
Appendix A for information about configuring the PCM Capture Properties dialog box.
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3. From the Control Mode drop-down list, select Automatic.

 

4. From the Options menu, select Output Format Settings to open the Output Settings
dialog box.

 

5. From the Stream Type drop-down list, select the type of audio file you want to produce.

Dolby® Digital (AC-3) stream type options:

Selection Description
Elementary Stream Elementary stream (AC-3 file format)

Elementary Stream with Time Code Elementary stream with time code (AC-3 file format)

IEC958 Stream Wave Format IEC958 stream (WAVE file format)

IEC958 Stream Wave Format
with Time Code

IEC958 stream with time code (WAVE file format)

 

NOTE: For Dolby® Digital (AC-3) encoding, if you select an item that contains time code,
the encoder will include time code in the bit stream.

MPEG Audio Layer 2 stream type options:

Selection Description
Elementary Stream Elementary stream (MPEG Audio Layer 2 file format)

IEC958 Stream Wave Format IEC958 stream (WAVE file format)
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6. From the Format drop-down list, select the type of IEC958 stream.

The tables shown below indicate which formats are Professional or Consumer mode, and
32-bit or 16-bit mode.

Dolby® Digital (AC-3) format options:

Selection Description
Professional 32-bit Bit stream on Channels 1 & 2

Professional 16-bit Ch 1 Data Packing Bit stream on Channels 1

Professional 16-bit Ch 2 Data Packing Bit stream on Channels  2

Consumer Bit stream on Channels 1 & 2
 

MPEG Audio Layer 2 format options:

Selection Description
Professional 32-bit Bit stream on Channels 1 & 2

Consumer Bit stream on Channels 1 & 2
 

7. From the Audio Status Bit drop-down list, select Non-Audio (Data). If the ZP-100 is
connected to a decoder that only accepts streams where the Audio Status Bit is audio,
select Audio.

8. Click OK to close the Output Format Settings dialog box.

9. Enter your desired start and stop time code using the HH:MM:SS:FF syntax. Time codes
can be entered by clicking on a specific time field, then typing a numeric value.

 Time codes may also be entered by clicking on the Start Time Code and Stop Time Code
buttons , located next to the time code text boxes, and using the Input Time Code
dialog boxes.

 

10. As an option, type a sample number into the Sample text box.

 One video frame may be divided into a number of PCM audio samples. The number of
PCM audio samples in a video frame is dependent on the PCM sampling frequency and
video frame rate. For example, when the PCM sampling frequency is 48 kHz and the
video frame rate is 24 fps, there are 2000 PCM audio samples in a video frame. Therefore,
this parameter allows you to narrow down your start time to a specific start sample within
a video frame. The default value is zero.
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11. From the Frame Rate drop-down list, select a frame rate.

 

12. Accept the default encoding parameters shown in the Audio Service Configuration, Bit
Stream Info 1, Bit Stream Info 2, and Processing tabs.

 If you want to learn how to adjust the encode parameters in these tabs, see Appendix A,
“Dolby Digital (AC-3) Encoding Parameters” and “MPEG Audio Encoding Parameters”.

13. Click the Encode button. The Audio Encoder System Executor window appears and the
default parameters begin downloading to the encoder.

 When the download is complete, the ZP-100 Controller queues your PCM audio player to
the start time code. When the Start Time code is reached, it will begin encoding the PCM
audio stream into a Dolby® Digital (AC-3) or MPEG Audio bit stream.

 When the ZP-100 reads the Stop Time Code, it will automatically stop encoding and stop
your PCM audio player.

 If the Cancel button is clicked, the encoding process will stop and the bit stream will not
be saved. If the Stop button is clicked, the amount that was encoded will be saved.
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14. If you specified a filename in the Capture Filename text box in Step 1, an audio file will
automatically be saved. If you leave the filename blank, an audio file will not be saved.

NOTE: Audio, parameter, and log files will be created; for more information, see the next
section, “Files produced by the ZP-100”.

Files Produced by the ZP-100
The ZP-100 can produce four types of files during an encoding session:

§ Parameter File

§ Log File

§ Stream Structure File (ZFS)

§ Audio File

Parameter Files
A parameter file is used for storing encoding parameters. There are two types of parameter
files. One is for Dolby® Digital (AC-3) encoding, and has the ZEP file name extension.
The other is for MPEG audio encoding, and has the ZMP file name extension. An
encoding session may use a default parameter file, or a unique one can be created and
configured to meet your encoding requirements. To learn how to create a unique
parameter file, see “Parameter Files” in Appendix A, “Encoding Parameters.”

Log File
A log file uses the LOG filename extension and is used for storing information about a
single encoding session. Each encoding session writes over the information contained in
the LOG file, so if you want to save this information, copy the log file to a separate
directory.

Depending on the type of encoding that is performed, the location of the LOG file can
change. When producing an audio file, the LOG file is in the same directory as the audio
file. It will have the same filename as the audio file, but with a “LOG” extension.

In Dynamic Encoding mode (For more information, see Appendix B, “Optimizing the
Encoding Parameters”), the LOG file will have the same filename as the parameter file,
but with a “LOG” extension. This type of LOG file can be found in the same directory as
the parameter file. However, if no unique parameter file is created during Dynamic
Encoding mode, a log file will be created using the name of the default parameter file
($A_TMP$.LOG), and can be found in the ZP-100 directory.
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Stream Structure File (ZFS)
A Stream Structure file is used for storing basic information about a captured file.
Information in these files is displayed in the PlayAudio main window.

Stream Structure files can be created by the ZP-100 or by PlayAudio. However, only a
ZFS created by the ZP-100 will contain Peak Wave data. PlayAudio uses Peak Wave data
to graphically display the audio file. These files have the ZFS file name extension.

Audio Files
The ZP-100 can produce three kinds of audio files:

§ Dolby® Digital (AC-3) file

§ MPEG Audio Layer 2 file

§ PCM audio file

Dolby® Digital (AC-3) audio files are produced using the ZP-100 Controller for Dolby
Digital (AC-3) encoding. Dolby® Digital audio files have the AC3 file name extension.

MPEG Audio Layer 2 files are produced using the ZP-100 Controller for MPEG audio
encoding. MPEG Audio Layer 2 files have the MP2 file name extension.

PCM audio files are produced using the ZP-100 Controller for both Dolby Digital (AC-3)
and MPEG audio encoding. PCM audio files have the WAV file name extension.

Quitting the ZP-100 Controller
If you are finished working with the ZP-100 Controller, quit by choosing Exit from the
File menu.

Playing Your Audio File
Included with your ZP-100 is PlayAudio. It can be used for playing your AC-3, MPEG, or
WAV files.  See the next chapter for information about using PlayAudio.
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C H A P T E R  4

Playing Your Audio File

Included with ZP-100 is PlayAudio. Use it for playing Dolby Digital (AC-3), MPEG
Audio Layer 2, PCM audio files. This chapter describes the PlayAudio main window and
how to use PlayAudio.

PlayAudio Main Window
Shown below is an illustration that describes the PlayAudio main window.
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Toolbar
The Toolbar provides shortcuts to the same commands that are located in the Menu Bar.
The illustration shown below describes each button on the Toolbar.

Peak Wave Pane
The Peak Wave Pane is located in the top-half of the PlayAudio main window. Use it for
viewing and selecting regions of an audio file. Selected regions can be saved as individual
audio files. Shown below is a diagram of the Peak Wave Pane.
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Peak wave information is supplied by Stream Structure Files (ZFS file). These files can be
created with ZP-100 Encoder while capturing a file, or by using PlayAudio. However,
only Stream Structure Files (ZFS file) created by the ZP-100 Encoder contain peak wave
data.

Starting PlayAudio
Three methods can be used to start PlayAudio.

To start PlayAudio, use one of the following methods:

§ Click on the Windows NT Start button, point to Programs, then to ZP-100, then select
PlayAudio to open the PlayAudio main window.

§ Move to the ZP-100 Controller main window, then from the Tools menu, select
PlayAudio to open the PlayAudio main window.

§ Double-click on any AC3 or MP2 file to open the PlayAudio main window.

After PlayAudio has started, you may have to select an output device.

Selecting an Output Device
PlayAudio sends the audio stream to the ZP-100, which then sends it to an external audio
decoder using either the SPDIF OUT or XLR OUT connectors of the Octopus Cable.

Your ZP-100 card is the default output device. Therefore, unless you want to send the
audio stream to a second ZP-100 or sound card, you do not have to select an output
device.

To select an output device:

1. Click the Options menu, and select Device to open the Output Device dialog box.
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2. Select which device will be used for playing your audio file.

 Select the ZP-100 Card radio button if you want to use your ZP-100 Encoder. If you have
two ZP-100 Encoders installed, select 0 or 1 from the Device No. drop-down list to
choose the one you want to use. When two encoders are installed, the one nearest the
computer’s CPU is typically identified by 0.

 Select the Sound Card radio button if you want to use a sound card. If you have multiple
cards installed, select the card from the Device drop-down list to choose the one you want
to use.

3. Click OK to save the configuration.

Opening an Audio File
PlayAudio can open AC3, MP2, or WAV files.

To open an audio file, use one of the following methods:

§ From the File menu, select Open and the Open dialog box will appear. Use the dialog box
to select the audio file, then click Open.

§ Drag an audio file from Windows NT Explorer into the PlayAudio main window.

§ Click the open audio file button  on the tool bar.

If there is no ZFS file for the PCM audio, the Select Frame Size dialog box will appear.
Select 1536 samples/frame if you want to open the PCM audio file using  AC-3 framing,
or select 1152 samples/frame if you want to open the PCM audio file using MPEG
framing.

Playing an Audio File
If an audio file is opened, it can be played at any time.

To play an audio file:

1. From the Controls menu, select Play to begin playing or click the play button  on the
tool bar.

2. Select Stop from the Controls menu or click the stop button  on the tool bar if you
want to stop playing before the end of the stream is reached.
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Selecting a Region of the Audio Stream
If peak wave data can be seen in the PlayAudio main window, you can select a specific
region of the audio stream, then play it.

To select a region of the audio stream:

1. Click on the Current text box  to open the Input Time Code dialog
box, and type in a time code where you want the selection to begin, or click the Peak
Wave Pane where you want the selection to begin

NOTE: This same method applies to the Frame text box .

2. From the Marker menu, select Set Start to create a start marker or click the start marker

button  on the tool bar.

3. Click on the Current text box  to open the Input Time Code dialog
box, and type in a time code where you want the selection to end or click the Peak Wave
Pane where you want the selection to end.

4. From the Marker menu, select Set End to create an end marker or click the end marker

button  on the tool bar.

Playing a Region of the Audio Stream
1. Select a region. See “Selecting a Region of the Audio Stream”.

2. From the Controls menu, select Play to begin playing or click the play button  on the
tool bar.

Saving a Region of the Audio Stream
1. Select a region. See “Selecting a Region of the Audio Stream”.

2. From the Marker menu, select Export to open the Save As dialog box or click the export

button  on the tool bar.

3. In the File name text box, type in a name for your new audio file.

4. Click Save to save the file.
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Properties Dialog Box
Use the Properties dialog box to set the basic input and output playing parameters. It can
be opened by selecting Properties from the Options menu or clicking the Properties button

 on the tool bar.

The table shown below describes the commands in the Properties dialog box.

Parameter Description
WAVE File Frame Size Use this drop-down list for framing the input audio file. Select

1536 sample/frame for AC-3 framing. Select 1152
samples/frame for MPEG framing. Note, if a ZFS file exists, this
control is not available.

Use Internal MPEG Decoder Select this check box if you want PlayAudio to decode the
MPEG audio file into a PCM format, then pass it through the
ZP-100 card or sound card, to a PCM audio player.

Clear this check box if you want the played MPEG audio to pass
through the ZP-100 card or sound card, and out to a MPEG audio
decoder.

Peak Wave Display Range This drop-down list controls the dB scale in the Peak Wave Pane.
Select -138.47 to 0.00 dBFs if you want to view the peak wave
using a full scale. Select –60.00 to 0.00 dBFs to view the upper
portion of the peak wave.

Advanced Properties
for ZP-100 Card

Opens the Advanced Properties for ZP-100 Card dialog box. For
more information, see the “Advanced Properties for ZP-100
Card Dialog Box” section later in this chapter.
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Advanced Properties for ZP-100 Card Dialog Box
Use the Advanced Properties for ZP-100 Card dialog box to configure the IEC958
Format properties. Use the following table as a guide.

This dialog box can only be opened when the ZP-100 Card radio button is selected from
the Selecting an Output Device dialog box.

The table shown below describes the commands in the Advanced Properties for ZP-100
Card dialog box.

Parameter Description
Format Type Use this drop-down list to configure the output audio as one of the following.

§ Professional 32-bit [use for AC-3, MPEG, and PCM audio]
§ Professional 16-bit Ch1 Data Packing [use for AC-3 audio]
§ Professional 16-bit Ch2 Data Packing [use for AC-3 audio]
§ Consumer [use for AC-3, MPEG, and PCM audio]

Audio Status Bit Use this drop-down list to set the audio status bit as Automatic, Non-audio
(data), or Audio.

Copyright Bit Use this drop-down list to set the copyright bit of the output audio. Protected
or Not Protected can be selected.

Emphasis Bit Use this drop-down list to set the emphasis type of the output audio. None,
50/15 microseconds, or CCITT J.17 can be selected.
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Report Pane Information
The Report Pane of the PlayAudio main window displays audio file information that was
generated during the encoding session. The information displayed in the pane is dependent
on which button is selected in the Button Pane. The table shown below describes the
information displayed in the Report Pane by those buttons.

File Button
Stream Button
(AC-3 Mode)

Stream Button
(MPEG Mode)

Stream Button
(PCM Mode) Peak Button Encode Log Button

File Name Frame Number Frame Number Frame Number Peak Max Parameter File

File Size Frame Size Frame Size Frame Size Peak Min Processing Time

File Format Time Stamp Info ID Sampling Frequency Ch1 Peak min/max Capture File

Stream Type Frame Rate Layer Quantization Ch2 Peak min/max PCM File

Sampling Frequency Drop Frame Flag Protection Bit Number of Channels Ch3 Peak min/max Sampling Frequency

Frames Audio Coding Mode Bitrate Ch4 Peak min/max Standby Emphasis

Samples LFE Channel Sampling Frequency Ch5 Peak min/max Encoded Frames

Play Time Bit Stream Mode Padding Bit Ch6 Peak min/max Encoded Size

Start Marker Bitrate Channel Mode Ch7 Peak min/max Error/Warning Messages

End Marker Sampling Frequency Mode Extension Ch8 Peak min/max Version

Duration Dolby Surround Mode Copyright Bit

Center Mix Level Original/Copy

Surround Mix Level Emphasis

Copyright Flag Ancillary Bit Length

Original Stream

Mixing Level

Room Type

Dialog Normalization

Compression Gain

Dynamic Range
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Menu Bar Reference
The Menu bar is located at the top of the PlayAudio main window. It has commands for
opening, playing, and selecting regions of an audio file. This section describes the
commands in each menu.

File Menu
Menu Item Description

Open 
Use to open AC3, MP2, and WAV files.

Exit Use to exit Play Audio.
 

View Menu
Menu Item Description
Toolbar Hides or shows the Toolbar.

Status Bar Hides or shows the Status Bar.

Split Activates the split pointer so that a Split bar that separates two panes
can be moved using the arrow keys of a keyboard.

Fit Mode 
Adjusts the scale of the peak wave so that the entire wave can be seen
in the Peak Wave Pane.

Zoom In 
Increases the resolution of the peak wave scales.

Zoom Out 
Decreases the resolution of the peak wave scales.

Center Cursor 
Finds the peak wave cursor.

 

Controls Menu
Menu Item Description

Stop 
Stops playing the audio file.

Play 
Plays the audio file.

Rewind 
Rewinds

Last Frame 
Move the cursor to the last frame of the audio file.

Pause 
Pauses the play.

Loop Playback 
Repeats playing.

Next 
Advances the cursor one frame.
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Previous 
Returns the cursor one frame.

Jump to Opens a submenu with the following commands.

Start Marker: moves the cursor to a Start Marker .

End Marker: moves the cursor to an End Marker .

Time: opens the Input Time Code dialog box.

Frame: opens the Input Frame Number dialog box.

 

Marker Menu
Menu Item Description

Clear 
Deletes a marker.

Undo Clear Reverses a deletion of a marker.

Set Start 
Creates a Start marker where the cursor is positioned.

Set End 
Creates an End marker where the cursor is positioned.

Export 
Saves a selected region of a stream as an individual audio file.

 

Options Menu
Menu Item Description
Device Opens the Output Device dialog box. See the “Selecting an Output

Device” section earlier in this chapter for more information.

Properties 
Opens the Properties dialog box. See the “Properties Dialog Box”
section later in this chapter for more information.

 

Window Menu
Menu Item Description
File Information Displays audio file information in the Report Pane.

Stream Information Displays stream information in the Report Pane.

Peak Information Displays peak wave information in the Report Pane.

Encode Log Information Displays encoding information in the Report Pane.
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A P P E N D I X  A

Encoding Parameters

The ZP-100 controller allows you to configure the encoding parameters according to your
needs and requirements. The parameters can be saved as a file that may be used for future
encoding sessions.

Appendix Outline
This chapter begins by describing all the encoding parameters, then describes the different
types of parameter files that can be created. A discussion of how to open, create, and save
parameter files is also provided. Listed below is an outline of this chapter.

§ Dolby Digital (AC-3) Encoding Parameters

§ MPEG Audio Encoding Parameters

§ PCM Audio Encoding Parameters

§ Parameter Files

§ Opening a Parameter File

§ Creating a Unique Parameter File

§ Saving Your Changes
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Dolby Digital (AC-3) Encoding Parameters
The Dolby Digital (AC-3) encoding parameters are located in four tabs of the ZP-100
Controller Main Window.

§ Audio Service Configuration Tab
§ Bit Stream Info 1 Tab
§ Bit Stream Info 2 Tab
§ Processing Tab

NOTE: For detailed technical information about Dolby® Digital (AC-3) encoding
parameters, see the ATSC standard AC-3 document at www.atsc.org/stan&rps.html.

Audio Service Configuration Tab
Use the Audio Service Configuration parameters to adjust the most basic Dolby® Digital
(AC-3) encoding parameters.

AUDIO CODING MODE

Use this parameter to configure the channel format and the number of audio channels to
encode. The table shown below explains each type of mode that can be selected.

Audio Coding Mode Description
1/0 (C) Encodes a monaural center channel.

2/0 (L,R) Encodes left and right channels.

3/0 (L,C,R)* Encodes left, right, and center channels.

2/1 (L,R,S)* Encodes left, right, and surround channels.

3/1 (L,C,R,S)* Encodes left, right, center, and surround channels.

2/2 (L,R,Ls,Rs)* Encodes left, right, left surround, and right surround channels.

3/2 (L,C,R,Ls,Rs)* Encodes left, right, center, left surround, and right surround
channels.

* Only available for 5.1 channel encoders.
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OTHER AUDIO SERVICE CONFIGURATION PARAMETERS

The table below describes the remaining Dolby® Digital (AC-3) parameters found in the
Audio Service Configuration tab.

Parameter Description
Bit Stream Mode Use this parameter to select the type of service that the Dolby Digital

(AC-3) bit stream conveys. The service types are Complete Main
(CM), Music and Effects (ME), Visually Impaired (VI), Hearing
Impaired (HI), Dialog (D), Commentary (C), Emergency (E), and
Voice Over (VO)/Karaoke. Most streams will use Complete Main. For
karaoke, use Voice Over (VO)/Karaoke.

Bit Rate Use this parameter to select a bit rate to encode. The table shows what
bit rates can be used for specific audio coding modes.

Audio Coding Mode Bit Rate Range
1/0 (C) 56000 to 640000 bps
2/0 (L, R) 96000 to 640000 bps
3/0 (L, C, R) 128000 to 640000 bps
2/1 (L, R, S) 128000 to 640000 bps
3/1 (L, C, R, S) 192000 to 640000 bps
2/2 (L, R, Ls, Rs) 192000 to 640000 bps
3/2 (L, C, R, Ls, Rs) 224000 to 640000 bps

Sampling
Frequency

Use this parameter to select the sampling frequency of the source
PCM audio stream: 32 kHz, 44.1 kHz, 48 kHz, or Auto. If Auto is
selected, the ZP-100 will automatically detect the sampling frequency
of the source PCM audio stream.

LFE Channel Use this parameter to include a LFE Channel in the stream. This
parameter is only available for 5.1 Channel encoders.

Channel
Assignment

Use these parameters for assigning a specific source PCM audio
channel to a specific Dolby Digital channel. A source channel is one
that can be physically transmitted across one of the AES/EBU or
SPDIF connectors of the Octopus cable.

Since 8 source channels can be sent to the ZP-100, each Dolby Digital
channel can be assigned any one of those 8 channels.

Save Use this button for saving the channel assignment for a specific Audio
Coding Mode. A unique configuration can be saved for each mode.
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Bit Stream Info 1 Tab
Use the Bit Stream Info 1 parameters to add data to specific information fields of the
Dolby® Digital (AC-3) bit stream.

Parameter Description

Dolby Surround Mode Use this parameter to indicate whether or not the Dolby® Digital
(AC-3) bit stream is conveying a Dolby® Surround encoded
program. This parameter is available only using Audio Coding
Mode 2/0. The parameter can be set to Dolby Surround encoded,
Not Dolby Surround encoded, or not indicated.

The Dolby® Surround Mode information is not used by Dolby®

Digital decoders, but may be used by Dolby® Surround decoders.

Surround Mix Level Use this parameter to set the nominal down-mix level of the
surround channel(s) with respect to the left and right channels.
This parameter is available when the Audio Coding Mode is set to
2/1, 2/2, 3/1, or 3/2. Values of 0.707 (-3.0dB), 0.500 (-6dB), and
0 (-Inf. dB) can be selected. This parameter is only available for
5.1 channel encoders.

Center Mix Level Use this parameter to set the nominal down-mix level of the
center channel with respect to the left and right channels. This
parameter is available when the Audio Coding Mode is set to 3/0,
3/1, or 3/2. Values of 0.707 (-3.0dB), 0.596 (-4.5dB), and
0.500 (-6dB) can be selected. This parameter is only available for
5.1 channel encoders.

Copyright Bit Use this parameter to copyright protect the Dolby® Digital (AC-3)
bit stream.

Original Bit Stream Use this parameter to flag the Dolby® Digital (AC-3) bit stream as
original material.
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Bit Stream Info 2 Tab
The remaining parameters for adding data to specific information fields of the Dolby®

Digital (AC-3) bit stream are located in the Bit Stream Info 2 tab.

Parameter Description
Audio Production Information This parameter indicates whether or not the Dolby®

Digital (AC-3) bit stream contains mixing level and room
type information.

Mixing Level: Use this parameter to select the acoustic
sound pressure level of the dialog during final audio
mixing. Values from 0 (80 dB) to 31 (111 dB) can be
selected.

Room Type: Use this parameter to select the type and
calibration of the mixing room used for the final audio
mixing. Values of Not Indicated, Large Room, and Small
Room can be selected.

If the source PCM audio is to be encoded for a movie
theater, choose Large Room. If the source PCM audio is
to be encoded for consumer equipment, choose Small
Room. If the encoding program is unknown, chose not
indicated. The Room Type is not typically taken into
account in Dolby® Digital (AC-3) decoders, but may be
used by other audio reproduction equipment.

Dialog Normalization Use this parameter to select the average dialog sound
pressure level. Values from -1 dB to –31 dB can be
selected.

Be aware that Dolby® Digital (AC-3) decoders
automatically adjust the average dialog level to –31dBFs.
For example, if –27 dB is used for dialog normalization,
the sound pressure level of the dialog will be reduced by 4
dB by the decoder. If 0 dB is used, the sound pressure
level of the dialog will be reduced by 31 dB by the
decoder. If –31 dB is used, the sound pressure level of the
dialog will not be reduced by the decoder.
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Processing Tab
Use the processing parameters to adjust the dynamic range compression and preprocessing
for your Dolby® Digital (AC-3) bit stream.

DYNAMIC RANGE COMPRESSION PARAMETERS

Parameter Description
Compression Setting Use this parameter to select the type of dynamic range

compression for your Dolby® Digital (AC-3) bit stream. The
types of compression that can be selected are None, Film
Standard, Film Light, Music Standard, Music Light, Speech.

RF Over Modulation Use this parameter to prevent over modulation if heavy
compression is needed. Heavy compression is targeted for
listening situations such as movie delivery to a hotel room or
airline seat.

A Dolby® Digital (AC-3) decoder will use the dynamic range
compression and RF over-modulation protection information
to reduce the audio program’s dynamic range unless the
feature is disabled on the decoder by the end user.

PRE-PROCESSING PARAMETERS

Parameter Description
Channel Bandwidth Low-pass Filter Use this parameter to apply a low-pass filter to the

main input channels (PCM input signals). The filter
cut-off frequency will be automatically set.

Since the low-pass filter reduces high frequency
signal information, the reduction in signal
information increases encoding efficiency, achieving
better sound quality at lower bit rates.

LFE Low-pass Filter Use this parameter to apply a 120 Hz low-pass filter
to the Low Frequency Effects input channel. If the
LFE input signal does not contain higher frequency
components than 120 Hz, the LFE Low-pass Filter
should not be used. This parameter is available only
for 5.1 channel encoders.

DC Filter Use this parameter to apply a DC filter to all input
channels. Since the removal of a DC component in
PCM input signal increases the encoding efficiency,
the quality of the sound will increase.

Surround Channel 90°° Phase Shift Use this parameter to apply a 90° phase-shift to the
surround channel(s). This feature is useful for
generating multi-channel Dolby® Digital (AC-3) bit
streams which can be down-mixed in an external
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2-channel decoder to create a true Dolby® Surround
compatible output. This parameter is only available
for 5.1 channel encoders.

Surround Channel 3 dB Attenuation Use this parameter to apply a 3 dB attenuation to the
surround channel(s). Apply this parameter if the
Dolby® Digital (AC-3) bit stream is targeted for
movie theaters. Do not apply this parameter if the
stream is targeted for consumer equipment. This
parameter is only available for 5.1 channel encoders.

Digital De-emphasis Use this parameter to apply a digital de-emphasis
filter to all input channels. If the PCM audio stream
is emphasized, it should be de-emphasized before it
is encoded.

If Auto is selected, the ZP-100 will automatically
detect whether or not the PCM audio stream is
emphasized. If the PCM audio stream is
emphasized, the ZP-100 will automatically activate
the digital de-emphasis filter.
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MPEG Audio Encoding Parameters
The MPEG Audio Layer 2 encoding parameters are located in three tabs of the ZP-100
Controller Main Window.

§ Basic Parameters Tab
§ Header Info Tab
§ Processing Tab

Basic Parameters Tab
Use the basic parameters to adjust the most fundamental MPEG encoding parameters.

Parameter Description
Audio Coding Mode Use this parameter to configure the channel format and the

number of audio channels to encode.
Mode Description
1/0 Single (C) Encodes a center monaural channel
1+1 Dual (L/Ch1, R/Ch2) Encodes a left (Ch1) &  right (Ch2)
channel
2/0 Stereo (L, R) Encodes left and right channels

Bit Rate Use this parameter to select a bit rate for the MPEG Audio bit
stream. The table shows what bit rates can be used for specific
audio coding modes.
Mode Bit Rate Range
1/0 Single (C) 56000 to 192000 bps
1+1 Dual (L/Ch1, R/Ch2) 112000 to 384000 bps
2/0 Stereo (L, R) 112000 to 384000 bps

Sampling Frequency Use this parameter to select the sampling frequency of the
source PCM audio stream: 32 kHz, 44.1 kHz, 48 kHz, or Auto.
If Auto is selected, the ZP-100 will automatically detect the
sampling frequency of the source PCM audio stream.

Channel Assignment Use these parameters for assigning a specific source PCM
audio channel to a specific MPEG channel. A source channel
is one that can physically be transmitted across one of the
AES/EBU or SPDIF connectors of the Octopus cable.

Since 8 source channels can be sent to the ZP-100, each
MPEG channel can be assigned any one of those 8 channels.

Save Use this button for saving the channel assignment for a
specific Audio Coding Mode. A unique configuration can be
saved for each mode.
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Header Info Tab
Use the header information parameters to add data to specific information fields of the
MPEG Audio bit stream

Parameter Description
CRC Use this parameter to activate the CRC check. If selected, CRC check

word will be generated and buried into MPEG Audio bit stream

Private Bit Use this parameter to set the private bit value within the MPEG Audio
bit stream. If selected, a bit of value ‘1’ is set. If not selected, a bit of
value ‘0’ is set.

Copyright Use this parameter to copyright protect the MPEG Audio bit stream.

Original Bit Stream Use this parameter to flag the MPEG Audio bit stream as original
material.

Emphasis Use this parameter to select the emphasis type of the PCM input
signal. If Auto is selected, ZP-100 will automatically detect the
emphasis type of the PCM input signal. ZP-100 supports three
emphasis types: None, 50/15 microseconds, and CCITT J.17.

Processing Tab
Use the processing parameters to optimize the sound qualities of the MPEG audio
encoding.

Parameter Description
Joint Stereo Use this parameter to apply ZP-100’s dynamic joint stereo coding

algorithm.

Joint Stereo coding utilizes the cross-correlation between left and right
channel data to provide better sound quality. Higher cross-correlation
increases sound quality. Therefore, the increase in sound quality by
Joint Stereo coding depends on how much left and right channel data
are correlated. However, in general, it provides better sound quality
for low bit rates.

Three modes can be used: Auto, On, and Off. If Auto is selected,
ZP-100 will dynamically activate or deactivate Joint Stereo coding
depending on the characteristics of PCM input signal, sampling
frequency, bit rate, and so on. If On is selected, Joint Stereo coding is
always activated. If Off is selected, Joint Stereo coding is always
deactivated.
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Bandwidth Limiting
Low-pass Filter

Use this parameter to apply a bandwidth limiting low-pass filter to the
PCM input signal. The filter cut-off frequency will be automatically
set depending on the sampling frequency, bit rate, and so on. At higher
bit rates (greater than 80,000 bps per channel for 44.1 kHz and 48
kHz), the filter is not activated. In case of 32 kHz, the filter is never
activated.

Since the low-pass filter reduces high frequency signal information,
the reduction in signal information increases encoding efficiency,
achieving better sound quality at lower bit rates.

PCM Audio Encoding Parameters
Use the PCM Capture Properties dialog box to configure all the PCM parameters. To
open the dialog box from the ZP-100 Controller Main Window, click on the PCM
Properties button. Described below are all the PCM encoding parameters.

Parameter Description
Sampling Freq. This text box indicates that the sampling frequency of the

source PCM audio data will be automatically detected. Rates
of 48 kHz, 44.1 kHz, and 32 kHz can be detected.

Quantization Use this parameter to select the quantization length of the
PCM sample. Quantization can be set to 16, 20, or 24 bits per
PCM sample.

Channels This text box automatically displays which channels will be
captured.

The channels captured depend on the item selected from the
Audio Coding Mode drop-down list. The drop-down list is
located in the ZP-100 Controller main window.

ZP-100 can capture a mono center channel or a left and right
channel.

Synchronize AC3/MPEG
Audio Frame

When automatically stopping an encoding session, the end
time code most probably will be somewhere in the middle of a
Dolby Digital (AC-3) or MPEG audio frame.

Clear this check box if you want to stop capturing PCM audio
(at the specific end time code) before the end of a Dolby

Digital (AC-3) or MPEG audio frame arrives. Select this
check box if you want the encoder to continue capturing past
the end time code until it reaches the end of the frame.
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PCM File Name Generate
Mode

Select this parameter to make the ZP-100 automatically name
your PCM capture file. Although dimmed, the name and its
path can be seen in the PCM Capture File Name drop-down
list.

Clear this check box to type in a unique file name in the drop-
down list. A name can be assigned to the file by clicking on
the Save As button located next to the drop-down list.

Parameter Files
Parameter files are used to store all the parameter settings for a specific encoding session.
When the ZP-100 controller is commanded to encode a PCM audio stream into a Dolby®

Digital (AC-3) or MPEG Audio bit stream, it sends all the parameters defined in the
currently open parameter file to the ZP-100. Encoding then begins based on the
configuration of each parameter.

All parameters are managed and configured in the ZP-100 Controller Main Window. The
ZP-100 Controller uses three types of parameter files: default and unique.

Default Parameter File
A default parameter file is used to store a specific set of encoding values, so when you
start the ZP-100 Controller, these values will automatically populate the encoding
parameters. Initially, there is no default parameter file. To create one, configure
parameters to suit your needs, then from the File menu, select Save As Default
Parameter File.

Unique Parameter Files
The ZP-100 controller allows you to adjust the parameters for a specific encoding session.
If you desire to save those adjusted settings for a future session, save them as a unique
parameter file. When a unique parameter file is in use, its name is shown in the title bar of
the ZP-100 controller main window.

Unique parameter files have two types of file name extensions.

§ ZEP for Dolby Digital (AC-3) files
§ ZMP for MPEG Audio files

Opening a Parameter File
To open a parameter file:

1. Select File from the main menu.

2. Click on Open Parameter File to display the Open dialog box.

3. Select the parameter file you want to open.
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4. Click the OK button.

Creating a Unique Parameter File
To save your unique parameters as a file:

1. Configure the parameters to values you require.

2. Select File from the main menu.

3. Click on Save As New Parameter File to display the Save As dialog box.

4. In the Save in drop-down list, select a folder where the file is to be saved.

5. Type the name for the parameter file into the File name drop-down list. The ZP-100
controller will automatically apply the correct filename extension.

6. Click the Save button.

Saving Your Changes
You may save your encoding session parameters anytime to a currently open parameter
file.

To save your parameters to a currently open parameter file:

1. Select File from the main menu.

2. Click on Save Parameters.
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A P P E N D I X  B

Optimizing the Encoding Parameters

Optimizing Your Selection of Encoding Parameters
The ZP-100 Controller allows you to change the values for specific encoding parameters
while the ZP-100 is encoding This feature gives you immediate audible feedback based on
your adjustments, thus allowing you to quickly optimize your parameter values. Once you
have optimized your parameters, you can save them for future encoding sessions.

NOTE: Procedures in this chapter use illustrations from the ZP-100 Controller for Dolby®

Digital (AC-3) encoding, however, they also apply to MPEG audio encoding.

To optimize a set of encoding parameters:

1. Start the ZP-100 controller.

2. The default parameter file will automatically load.

 If you want to use an existing unique parameter file, use the File menu to select Open
Parameter File. Use the Open dialog box to select a parameter file. Unique parameter
files will have the ZEP file name extension for Dolby® Digital (AC-3) parameter files and
ZMP file name extension for MPEG Audio parameter files.

3. Ensure that the Capture Filename text box should be clear.

4. Begin playing the PCM audio stream.

5. Click the Encode button. The Encode button will then be renamed to Change.

6. Begin listening to the decoded bit stream.
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7. Based on your aural inspection, make adjustments to parameters that do not meet your
requirements.

 

8. Click the Change button to apply all your adjusted parameters.

9. If you are not satisfied with the sound quality, repeat steps 7 and 8. If you are satisfied
with the sound quality, you may save the new parameter values as described in the next
section.

Saving Your New Parameter Values
You may save your new parameter values to a currently open parameter file or save them
as a new parameter file.

To save your adjusted parameters to a currently open parameter file:

1. Click the File menu item.

2. Click on Save Parameters.

To save your parameters to a new parameter file:

1. Click the File menu item.

2. Click on Save As New Parameter File and the Save As dialog box will appear.

3. Type the name for your new parameter file in the Save in drop-down list. The ZP-100
Controller will add the default file name extension ZEP for Dolby Digital files or ZMP for
MPEG audio files.

4. Click on the Save button.

Note: When a parameter is adjusted, the text will change color and an asterisk (*) will
appear in the title bar. Saving or encoding removes the asterisk and color change.
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A P P E N D I X  C

The Main Menu

This chapter describes all the commands located on the main menu.

File Menu
The File menu is used for creating and managing parameter files. When a parameter file
has been selected, its name is displayed in the title bar of the main window.

Open Parameter File
Use this command to open an existing parameter file.

Save Parameters
Use this command to save all parameter settings to the currently open parameter file.

Save As New Parameter File
Use this command to save an open parameter file as a new parameter file with a new
filename. The original parameter file and its name will not be deleted.

Save As Default Parameter File
Use this command to over-write the default parameter file.

Exit
Use this command to close ZP-100 controller. This command will not automatically save
changes to your parameter files.
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Options Menu

Output Format Setting
Choosing this menu item opens the Output Format Settings dialog box.

Use the Stream Type drop-down list to select the type of audio file you want to produce.

Dolby® Digital (AC-3) stream type options:

Selection Description

Elementary Stream Elementary stream (AC-3 file format)

Elementary Stream with Time Code Elementary stream with time code (AC-3 file format)

IEC958 Stream Wave Format IEC958 stream (WAVE file format)

IEC958 Stream Wave Format with Time
Code

IEC958 stream with time code (WAVE file format)

 

NOTE: For Dolby® Digital (AC-3) encoding, if you select an item that contains time code,
the encoder will also include time code in the bit stream.

MPEG Audio Layer 2 stream type options:

Selection Description

Elementary Stream Elementary stream (MPEG Audio Layer 2 file format)

IEC958 Stream Wave Format IEC958 stream (WAVE file format)
 

Use the Format drop-down list to select the type of IEC958 stream.

The tables shown below indicate which formats are Professional or Consumer mode, and
32-bit or 16-bit mode.

Dolby® Digital (AC-3) format options:

Selection Description

Professional 32-bit Bit stream on Channels 1 & 2

Professional 16-bit Ch 1 Data Packing Bit stream on Channels 1

Professional 16-bit Ch 2 Data Packing Bit stream on Channels 2

Consumer Bit stream on Channels 1 & 2
 

MPEG Audio Layer 2 format options:

Selection Description

Professional 32-bit Bit stream on Channels 1 & 2

Consumer Bit stream on Channels 1 & 2
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 From the Audio Status Bit drop-down list, select Non-Audio (Data). If the ZP-100 is
connected to a decoder that only accepts streams where the Audio Status Bit is audio,
select Audio.

Encoder Settings
This menu item opens the Encoder Settings dialog box. The following table describes
each control.

Control Description
PCI Device No. If two ZP-100 Encoders are installed, select 0 or 1 from the PCI

Device No drop-down list to assign a specific Encoder to the
controller. Otherwise, accept the default value. Typically, the
Encoder nearest your computer’s CPU is identified as 0.

Number of Buffers Personal computers with slow microprocessors may experience
system crashes. To help resolve this problem, increase the
computer’s memory buffer size.

If necessary, increase buffer size from the Number of Buffers
text box. Each integer equals 64K of memory space with a
maximum of 128 buffers.

Select Interface for
Ch1 and Ch2

A two channel PCM audio stream can be accepted as an input to
the ZP-100 Encoder at the plugs labeled Ch 1-2 or SPDIF IN.

Depending on how the encoder is connected to the player, select
AES/EBU if using the Ch 1-2 plug, or SPDIF if using the SPDIF
IN plug.

During Standby Standby is a mode when the ZP-100 Encoder is monitoring a
source audio stream, but not encoding.

Use this drop-down list to configure the encoder’s output at the
XLR OUT and SPDIF OUT plugs during standby mode. Since
both of these plugs supply an output to an audio decoder, select
PCM if your decoder can play PCM audio, otherwise, select
Mute.

Note: Located in the Audio Service Configuration tab of the ZP-
100 Controller main window is the Audio Coding Mode drop-
down list. If set to 1/0 Single (mono), Channels 1 and 2 of the
XLR OUT and SPDIF OUT plugs will supply mono audio.
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During Encoding Use this drop-down list to configure the encoder’s output at the
XLR OUT and SPDIF OUT plugs during encoding mode. Since
both of these plugs supply an output to an audio decoder, select
Encoded Stream if your decoder can play Dolby® Digital (AC-3)
and/or MPEG audio, otherwise, select PCM.

Note: Located in the Audio Service Configuration tab of the
ZP-100 Controller main window is the Audio Coding Mode drop-
down list. If set to 1/0 Single (mono), Channels 1 and 2 of the
XLR OUT and SPDIF OUT plugs will supply mono audio.

Time Code Start/End When doing semi-automatic or automatic encoding, set the
accuracy of the start and end time codes.

Select Time Code >= Specified Start/End Time Code to make
the encoder automatically start or stop if it recognizes that a
specific time code has appeared and/or passed. The encoder may
not start and stop correctly because of a poor quality time code
signal supplied by the PCM audio player.

Select Time Code = Specified Start/End Time Code to
automatically start or stop encoding when encoder actually reads
the specific time code. If a specific start time code was not
received by the encoder for some reason, it will remain in
standby, and if a specific end time code was not received,
encoding will continue if this selection is used.

Create ZFS file A ZFS file, also called a Stream Structure file, contains
information about the AC3, MPEG, and PCM files. PlayAudio
displays information from this file in its main window. Select this
checkbox to automatically create a ZFS file whenever you
encode. The ZFS will have the same name, and be found in the
same location as your captured file, but using the ZFS filename
extension.
Although PlayAudio can create ZFS files when needed, it does
not include peak wave data, the graphical representation of the
captured file. Only ZFS files created by using this checkbox
contain peak wave data.

Erase Capture file if… Select this checkbox if you want to delete your captured file if
some fatal error occurs during the encoding session.

Display ATSC
Check this command if want the ZP-100 controller  to display the ATSC naming
conventions in the Bit Stream Info 1 and Bit Stream Info 2 tabs.
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Tools Menu
The Tools menu lists your current audio files. Selecting any of the files automatically
starts PlayAudio.

About Menu

About
This command opens the About Window that shows what version of the ZP-100 controller
you have.
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A P P E N D I X  D

Default Encoding Parameters

Dolby Digital Default Parameters
Listed below are the default parameter values used for Dolby Digital (AC-3) encoding.

Encoding Parameter Value for 5.1 Ch Value for 2 Ch
Audio Coding Mode: 3/2 2/0

LFE Channel: On (checked) N/A
Bit Rate: 448000 bits/s 192000 bits/s

Bit Stream Mode: Complete Main Complete Main
Sampling Frequency: Auto Auto

Left Channel Assignment: 1 1
Right Channel Assignment: 2 2

Left Surround Channel Assignment: 3 N/A
Right Surround Channel Assignment: 4 N/A

Center Channel Assignment: 5 1
LFE Channel Assignment: 6 N/A

Surround Channel Assignment: 3 N/A
Dolby Surround Mode: Not Indicated Not Indicated

Surround Mix Level: 0.707 (-0.3dB) N/A
Center Mix Level: 0.707 (-0.3dB) N/A

Copyright Bit: On (checked) On (checked)
Original Bit Stream: On (checked) On (checked)

Audio Production Info. Exists: Off (clear) Off (clear)
Dialog Normalization: -27 dB -27 dB

Dynamic Range Compression Setting: Film Standard Film Standard
RF Over Modulation Protection On (checked) On (checked)

Channel Bandwidth Low-pass Filter: On (checked) On (checked)
LFE Low-pass Filter: On (checked) N/A

DC Filter: On (checked) On (checked)
Surround Channel 90° Phase-Shift: On (checked) N/A
Surround Channel 3dB Attenuation: Off (clear) N/A

Digital De-emphasis: Auto Auto
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MPEG Audio Default Parameters
Listed below are the default parameter values used for MPEG Audio encoding.

Encoding Parameter Value
Audio Coding Mode: 2/0 Stereo

Bit Rate: 22400 bits/sec
Sampling Frequency: Auto

Left Channel Assignment: 1
Right Channel Assignment: 2

Center Channel Assignment: 1
CRC: On (checked)

Private Bit: Off (clear)
Copyright Bit: On (checked)

Original Bit Stream: On (checked)
Emphasis: Auto

Joint Stereo: Auto
Bandwidth Limiting Low-pass Filter: Off (clear)
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A P P E N D I X  E

Batch Encoding

Batch encoding involves creating two or more parameter files, then running a program
that automatically runs the ZP-100 Controller by using the parameter files. The following
is an example of batch encoding.

To do batch encoding:

1. Create a directory, d:\Batch.

2. Configure and save the encoding parameters in d:\Batch directory.

3. Repeat step 2 for as many parameter files as you want to create.

4. Open a common text editor, for example, Notepad.

5. Type the following commands.

@echo off
aexecute /pd:\batch\parameterfilename1.zep
aexecute /pd:\batch\parameterfilename2.zmp
aexecute /pd:\batch\parameterfilename3.zep

6. Save as a text file with the BAT file name extension in the ZP-100 install directory, for
example, c:\program files\zapex\ZP-100\.

7. From the Windows NT taskbar, click Start, point to Programs, then select Command
Prompt to open the Command Prompt window.

8. Move to the ZP-100 install directory (c:\>cd c:\ program files\zapex\ZP-100).

9. Type in the name of your batch file you saved, then press Enter to begin the batch
encoding session.



62 ZP-100 User’s Guide



Appendix F  Regulatory Approvals 63

A P P E N D I X  F

Regulatory Approvals

Radio Frequency Interference (RFI) Ratings
FCC Class A, CE (EN 55022A, EN 50082-1), VCCI Class A

FCC Statement
This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15, subpart B, of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference in which case the user will be
required to correct the interference at his or her own expense.

Modifications or changes to this product not expressly approved by Zapex Technologies,
Inc. could void the user’s authority to operate the equipment.

To insure compliance with FCC non-interference regulations, shielded interface cables
should be used to attach all peripherals.

If this equipment does harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and the receiver.
• Connect the equipment to an outlet on a circuit different from that to which the

receiver is connected.
• In case of TV or radio interference, turn the antenna until the interference stops, or

consider installing an antenna with coaxial cable lead-in between the antenna and TV.
• Consult Zapex Technologies, Inc. technical support.
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VCCI
This is a Class A product based on the standard of the Voluntary Control Council for
Interference by Information Technology Equipment (VCCI). If this equipment is used in a
domestic environment, radio disturbance may arise. When such trouble occurs, the user
may be required to take corrective actions.

CE Statement
Marking by the symbol CE indicates compliance of this device to the EMC directive of
the European Community. Such marking in indicative that this Zapex system meets or
exceeds the following technical standards:

CISPR 22 (EN 50082-1)

“Electromagnetic compatibility - Generic immunity standard Part 1: Residential,
Commercial and Light industry.”

EN 55022

“Limits and Methods of Measurement of Radio Interference Characteristics of
Information Technology Equipment.”

IEC 801-2

“Electromagnetic compatibility for industrial-process measurement and control equipment
Part 2: Electrostatic discharge requirements.” - Severity level 3, performance criterion B.

IEC 801-3

“Electromagnetic compatibility for industrial-process measurement and control equipment
Part 3: Radiated electromagnetic field requirement.” - Severity level2, performance
criterion A.

IEC 801-4

“Electromagnetic compatibility for industrial-process measurement and control equipment
Part 4: Electrical fast transient/burst requirements.” - Severity level 2 performance
criterion B. A “Declaration of Conformity” in accordance with the above standards has
been made and is on file at Zapex.



Appendix G  Physical and Environmental Specifications 65

A P P E N D I X  G

Physical and Environmental Specifications

Electrical: 100 to 240 VAC, 50/60Hz
Operating Temperature: +10°C to +35° (+50°F to 95°F)

Storage Temperature: -20°C to +50°C (-4°F to 122°F)
Humidity: Less than 80% (non-condensing)

Altitude: 0 to 3048m (0 to 10,000ft.)

Agency Approvals:
Emissions: FCC Class A, CE (EN 55022A, EN 50082-1),

VCCI Class A
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A P P E N D I X  H

Use of Dolby Trademarks for Audio

Introduction
Dolby Laboratories owns the trademarks “Dolby” and the double-D symbol “2,”which
are registered in over 90 countries in the world. The marks are used on a variety of
professional noise reduction products, cinema equipment and signal processor
manufactures and sold by Dolby Digital Laboratories, Inc.

Use of the Dolby Trademarks is licensed to manufacturers of audio and video equipment.
The appearance of one or more of the trademarks on a licensed product indicates that the
product contains technology developed by Dolby Laboratories and that it meets
performance standards set by Dolby Laboratories Licensing Corporation (DLLC).

Use of the Dolby Trademarks is also licensed to prerecorded audio and video companies
whose products are made using technology developed by Dolby Laboratories. The
appearance of any of the Dolby Trademarks on prerecorded media indicates that it was
produced using one or more Dolby technologies and that it meets performance standards
set by DLLC. Examples of the Dolby Trademarks available to licensees for identifying the
specific technologies used in production and manufacturing are:

Dolby Trademark Logo: For soundtracks recorded using:

1 Dolby Digital (AC-3) audio coding

3 Dolby Surround or when the soundtrack have been transferred from a
Dolby theatrical release

6 Dolby Net audio coding

For audio tapes recorded using:

! or s Dolby B-type noise reduction

# or t Dolby S-type noise reduction

& or u both Dolby B-type noise reduction and Dolby HX Pro headroom
extension

* or v both Dolby S-type noise reduction and Dolby HX Pro headroom
extension
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Trademark and Standardization Agreements
Like any material property, a trademark may not be used by others without permission of
the trademark owner. Also, if a trademark is licensed to others, the trademark owner must
set quality standards and see that they are adhered to so that the use of the trademarks by
others does not undermine the good reputation of the marks. In addition to these rather
straightforward requirements, trademark law also demands that trademarks be used in
somewhat restricted ways.

So that it and its licensees can comply with requirements of trademark licensing law,
DLLC provides Trademark and Standardization Agreements for companies who wish to
use the Dolby Trademarks on their audio and video media. These Agreements are royalty-
free, and as a special incentive to promote the use of the Dolby Surround, Dolby Digital,
and Dolby Net Trademarks, there is currently no processing fee for those trademark
licenses. All other trademark licenses require a one-time $300 fee for processing the
trademark license application. This fee is reduced to $250 in the case of audio cassettes
manufactured by a Dolby Approved Duplicator.

A separate Agreement must be signed for each technology prior to use of the
corresponding Dolby Trademark. The main points of the Agreements are as follows:

1. An authorization for the licensee to use the Dolby Trademarks on prerecorded media
produced with Dolby noise reduction and/or Dolby HX Pro headroom extension, Dolby
Surround, Dolby Digital or Dolby Net technologies;

2. Specifications for the correct use of the Dolby Trademarks and for acknowledging the
ownership of the marks;

3. Specifications of the quality control arrangements, which involve the licensee providing
occasional samples for quality appraisal.

WHO SHOULD SIGN THE TRADEMARK AND STANDARDIZATION AGREEMENT

A company that owns the rights to a piece of music or other recording, and is involved in
the preparation, production and sale of prerecorded media incorporating Dolby technology
must sign an Agreement if it wishes to use the Dolby Trademarks on the media released
under the company's own labels.

A company which, under contract, simply manufactures prerecorded media for one or
more customers (Dolby licensees), and/or is only involved in the preparation of artwork
(labels, boxes, jackets, insert cards) need not sign an Agreement.

Responsibility for the quality of recordings and proper trademark usage rests with the
licensee.

LICENSING PROCEDURE

A company interested in using Dolby Trademarks on its prerecorded video or audio media
should contact DLLC for licensing information and to request a license.

DLLC sends a questionnaire and the appropriate Agreements to licensee for review and
completion.
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Licensee returns the completed questionnaire, signed Agreements and the appropriate
processing fee (payable to Dolby Laboratories Licensing Corporation) to DLLC. In the
case of tape-based formats such as audio and video cassette, a sample recording must also
be submitted for quality evaluation. Test samples are acceptable, but only if they are
manufactured using the same processes and equipment as the product which will
eventually be distributed to the public. Samples of non-tape formats may be sent later,
once the final product has been completed.

DLLC countersigns and returns one copy of each Agreement along with the appropriate
trademark artwork.

Subsequent to signing an Agreement, we ask that licensees provide us with sample copies
of materials which incorporate the Dolby Trademarks, such as discs, cassettes, insert
cards, catalogs and advertisements, so that we can verify that our trademarks are being
used correctly. If licensees have any doubts about correct trademark usage, we ask that
they please contact us. We are always happy to check drafts of material to be printed or
used in advertising and promotion, and to give advice on the correct use of our
trademarks. We may also require the licensee to periodically submit product samples so
that we may check the soundtrack quality and verify proper trademark use.

A NOTE TO REPLICATORS AND STUDIOS

Your clients may not be aware of the fact that a license Agreement with DLLC is required
before Dolby Trademarks may be used on their products. Strictly speaking, it is our
responsibility to provide information to new customers, but we need to know who those
customers are. Accordingly, if your clients wish to use our trademarks we must rely on
your cooperation to refer them to us so that licensing formalities can be completed.

Dolby Laboratories Licensing Corporation
100 Potrero Avenue
San Francisco, CA 94103-4813
USA

Phone: 415-558-0200
Fax: 415-863-1373
E-mail: tsa@dolby.com
http://www.dolby.com

or at

Wooton Bassett
Wilshire SN4 8QJ
England

Phone: 01-793-842100
Fax: 01-793-842101
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Zapex Technologies, Inc.
2432 Charleston Road   Mountain View, California 94043   http://www.zapex.com


